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 מבוא
, מאחדת ביחידות הקודמות נכנסות אל תוך מסגרת פגשנוש למה כל העקומות נברר זוביחידה 

היוונים הקדומים כבר חקרו לעומק את הצורות ההנדסיות הקלאסיות במישור ". חתכי חרוט"הנקראת 

 . עם המחשבןנחקור אותאנחנו . ובמרחב

נעבוד גם עם  . על מנת להשתמש בתכונות גרפיות מיוחדות שלוDerive 6  העבודה נעשה בעזרתאת 

 -ניתן להוריד את ה, שיצרנו בעזרת תוכנה זו כדי לפתוח את הקבצים DPGraph:  הגרפיתהתוכנה

Viewerחינם מן האתר http://www.dpgraph.com   -  את להפעיל לראות את השרטוטים וכך תוכלו

 .יחידה בסוף המופיעות בנספח DPGraph עם התוכנה הלעבודהנחיות  ,יותהאנימצ

 

 

 

 

 

 

 

 

 

 :רשימת הפעילויות

 מימדי- תלתחלון גרפיהתמצאות ב – 10.1פעילות 

 חרוט  חתך – 10.2פעילות 

 עם מישור משתנהחרוט חיתוך של  – 10.3פעילות 

 חתכי חרוט מנוונים – 10.4פעילות 

 DPGraph בעזרת –ר משתנה ל חרוט עם מישושהחיתוך : נספח
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 מימדי-תלתגרפי  חלוןהתמצאות ב – 10.1פעילות 
 לא a, b, c שבה המקדמים ax + by + cz + d = 0משוואה  קרטזית של מישור היא משוואה מהצורה 

 . זמנית- בואפס -יכולים להיות שווים ל

 . x -המישור מקביל לציר ה ,a = 0אם  .א

 .y – 2z – 1 = 0  - ו 2y + z – 2 = 0 הבא  הן טוטשרלדוגמא משוואות המישורים ב  

 :השלימו

 . _____-המישור מקביל לציר ה, b=0אם 

 ._____ -המישור מקביל לציר ה, c=0אם 

 .המישור עובר דרך ראשית הצירים, d=0אם 

 .הדגימו בשרטוט

 
 .ממדי-הקליקו בסרגל הפקודות על         לפתיחת חלון גרפי תלת

 

 .    לשרטוטהקישו על    

 

בעזרת אחד הכפתורים                                 ניתן לסובב את מערכת הצירים ולראות את המשטח ששרטטתם 

 .נסו זאת. מכיוונים שונים

 :שינוי צבע השרטוט

 .הקליקו בתוך השרטוט ויפתח תפריט לשינויים

 Options > Annotate New Plots: ספת משוואת המישור לשרטוט באופן אוטומטילהו

 .z = kיש לו משוואה מהצורה , ורק אם,  אםxyהמישור מקביל למישור  .ב

 .z = -4 ,z = 0 ,z = 3 משוואות המישורים באיור הבא הן  :הלדוגמ 

 



 

 מורהל – חתכי חרוט                                 התרבות והספורט,  כל הזכויות שמורות למשרד החינוך©

3

 :השלימו

 ._____יש לו משוואה מהצורה , ורק אם,  אםyzהמישור מקביל למישור 

 .שרטטו שלושה מישורים כאלה

 . _____יש לו משוואה מהצורה , ורק אם,  אםxzר המישור מקביל למישו

 .שרטטו שלושה מישורים כאלה

 .באותו שרטוט) xz ומישור yzמישור , xyדהיינו מישור (שלושת מישורי המערכת את שרטטו 

 :מישורים מקבילים    .ג

 . P’: a’x + b’y + c’z + d’ = 0 - וP: ax + by + cz + d = 0מישורים  נתונים שני 

 . הן פרופורציונליות(’a’, b’, c) -  ו(a, b, c)שלשות המקדמים , ורק אם, לים אםהם מקבי

 :הלדוגמ

 ).' שרטוט אורא(הם מקבילים .  P’: 4x – 6y +  2x  + 5 = 0  -  וP: 2x – 3y + z – 7 = 0נתון 

 ).'ט ב שרטוורא(הם לא מקבילים .   P’: 2x - 6y + 2z + 5 = 0 -  וP: x + 3y +2z + 1 = 0נתון 

 )ב)                                                              (א                         (

 .סובבנו את מערכת הצירים, בין שני השרטוטים: שימו לב

מצאו את המישור , Deriveבעזרת . x – 2y + y –2 = 0נתון מישור שמשוואתו היא :  תרגיל

 .(1,3,2-)בר דרך הנקודה  והעומישור הנתוןהמקביל ל

 

 .של המשוואה המקדמים ת את השפעחקרו .ד

 .dהשפעת המקדם   
 .x + y + z + d = 0רשמו בחלון האלגברי את המשוואה  .1
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 לפני שתוכלו לשרטט מישורים השייכים למשפחה – 3D. עברו לחלון הבעזרת הכפתור  .2

 :ת שיחת תיבנפתח. Insert>Slider Barבחלון הגרפי על  הקישו       

 - וסמנו בקליק במשבצת התחתונה שאתם מבקשים עדכון השרטוט תוך כדי גלישת הdכשם משתנה רשמו את 

Slider Bar) שינינו את , בתמונה לעיל. הכניסו לפי שקולכם, את הנתונים המספריים). בעברית סרגל גלישה

 .Deriveבחירות המחדל של 

 ?מה אתם מקבלים. - 3D בחלון ה שוב על הכפתור הקישועכשיו  .3

 ?מה קורה. לאט לאט הזיזו את הכפתור הנייד של הסרגל .4

 :להלן דוגמאות". הזזה מקבילה של המישור"בעצם מה שבצענו הוא 

 .נובעות מזה ששמרנו על מסגרת התיבה" מוזרות"הצורות ה: שימו לב
 

 

 :העברת שרטוט מהחלון הגרפי לחלון האלגברי

בהקלקה על התמונה . תוכן החלון הגרפי יעבור לחלון האלגברי. Embedבחרו ) בחלון הגרפי (Fileמתפריט 

 ).ואז אפשר לעדכן את התמונה( בחלון האלגברי יפתח החלון הגרפי עם התמונה 
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 a  השפעת המקדם

 . בחלון אלגברי חדשax + y + z + 1 = 0רשמו את המשוואה  .1

 כמשתנה עבור סרגל dמקום  בa(עם ההתאמות הדרושות  , הקודםחלק החזרו על הסעיפים של  .2

 ).הגלישה

 ?מה קורה .3

 

 bהשפעת המקדם 

 . בחלון אלגברי חדשx + by + z +1= 0רשמו את המשוואה  .1

 כמשתנה עבור סרגל d במקום b(עם ההתאמות הדרושות  , לעיל'  ה–' חזרו על הסעיפים ב .2

 ).הגלישה

 ?מה קורה .3

 

 :הבאותי המשוואות "את המישורים הנתונים ע שרטטו באותו שרטוט .ה
x + y + z +1 = 0,  x – y + z + 1 = 0, -x + y + z + 1 = 0, -x – y + z + 1 = 0 

 .זהו בשרטוט כל אחד מהמישורים     

  

 name10.1.dfw, שמרו את הקובץ שבניתם בשם שלכם 
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 10.1פתרונות והסברים לפעילות 

 dfw..110solution: ראו גם קובץ

 
 . x -המישור מקביל לציר ה ax + by + cz +d = 0, a = 0במשוואת המישור אם  .א

 .y -המישור מקביל לציר ה ,b = 0אם        

 .z -המישור מקביל לציר ה ,c = 0אם         

 .עובר דרך ראשית הציריםהמישור  ,d = 0אם        

 

 .z = kמהצורה  יש לו משוואה, ורק אם,  אםxyמקביל למישור המישור  .ב

 .x = kיש לו משוואה מהצורה , ורק אם,  אםyzהמישור מקביל למישור        

  .y = kיש לו משוואה מהצורה , ורק אם,  אםxzהמישור מקביל למישור        

  x = 0, y = 0, z = 0: שרטוט שלושת מישורי המערכתלהלן        

 .ידי התוכנה בהצגתם הפרמטרית- נרשמו עלx = 0, y = 0       שימו לב שהמישורים 
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 (2 ,3 ,1-)את שיעורי הנקודה הנתונה  x – 2y + z + d =0במשוואת מישור נציב : פתרון התרגיל .ג

  x – 2y + z + 5 = 0.: משוואת המישור המקביל למישור הנתון היא. d = 5ונמצא כי 

 

בשרטוטים להלן רואים . x -המישור מקביל לציר a = 0ראינו לעיל כי כאשר  :aהמקדם  השפעת .ד

  ).משמאל (a = 2 -ו) מימין (a = -7 עבור  x -בוב המישור ביחס לציר את סי

 

       

 

 

 

 

 

 

 

בשרטוטים להלן רואים . y - המישור מקביל לצירb = 0ראינו לעיל כי כאשר  :bהשפעת המקדם 

 ). משמאל(b = 3  -ו) מימין (b = -3 עבור  y -את סיבוב המישור ביחס לציר 
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בצד (ים בשרטוט לפי צבעי הכתוביות המתאימים לצבעי השרטוט  ניתן לזהות את המישור .ה

 .Derive)ראו שרטוט בקובץ (  למישוריםמאונכיםוקטורי יחידה הולפי ) העליון
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 חתך חרוט – 10.2פעילות 
 חרוט: הקדמה

המשטח . C נתונה עקומה Pבמישור  . P לא על A ונקודה Pמימדי נתונים מישור -במרחב התלת

, cone) או conusבאנגלית  (חרוט נקרא C ונקודה אחת של Aי כל הישרים העוברים דרך "צר עהנו

  . של החרוטקו יוצר נקרא C וחותך את Aישר העובר דרך . של החרוט הקדקוד היא Aהנקודה 

 

חרוט  בשם Cקוראים לחרוט , P- מאונך לAB כך שהישר B היא מעגל בעלת מרכז Cאם העקומה 

 .  הנקרא ציר החרוטAB  מסביב לישר DE הוא נוצר מסיבוב הישר כי של סיבוב

 חרוט של סיבוב עם שניים מיוצריו

על ישר מאונך למישור זה העובר . במישור נתון נעיין  בשני מעגלים בעלי אותו מרכז ורדיוסים שונים

ים הם  והנשענים על המעגלAהחרוטים הנבנים עם קדקוד . Aה דדרך מרכז המעגלים נבחר נקו

 : הבאשרטוטכפי שרואים ב, יותר מהשני" פתוח"אחד מהם : שונים זה מזה

B • 

E

A

D

p

A
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 החרוט הנקרא, אבל נעבוד במקרה המיוחד, מה שנלמד מעתה הוא נכון עבור כל חרוט של סיבוב

2 שמשוואתו היא הסטנדרטי 2 2x y z+ = . 

Deriveי משוואה המגדירה את " עגרף נתוןאבל לא ,  של שני משתנים יודע לשרטט גרף של פונקציה

z כפונקציה סתומה של xו - y.  

 ?מה מתקבל.   Solveבעזרת הפקודה y - וx כפונקציה של zנבטא את , לכן

 .3D  -החרוט בחלון השתי יריעות את          אפשר לשרטט  עכשיו

 
. יריעות ייקראו אשר,  שרטט את החרוט כאיחוד של שני חלקים Derive-הצבעים השונים מראים ש

 !במתמטיקה חרוט מורכב משתי יריעות, בניגוד להרגל היום יומי, שימו לב

axנזכור שמשוואה קרטזית של מישור במרחב היא  by cz d 0+ + +  הוא איפוא  חתך החרוט. =

 :קבוצת האמת של מערכת המשוואות הבאה
2 2 2x y z

ax by cz d 0
 + =


+ + + =
 . 

 

  .שרטטו את החרוט הסטנדרטי .א

 .. x + y – z + 1.5 = 0את המישור שמשוואתו היא שרטטו אותו באותו חלון 

 ?מה אתם רואים, אם כן? שרטטם את המישור      
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לחיצה נוספת . 3D - בחלון ה את השרטוט בעזרת הכפתור סובבו, כדי לשפר את המצב

 . עוצרת את התנועה

 

. שונים" צדדים"זה משום שאנו רואים אותו משני . ניםל בשני צבעים שו"המישור מופיע בשני השרטוטים הנ

Derive ראינו כבר את זה עם החרוט ). או צד פנימי וצד חיצוני( מאפשר להבדיל בין צד עליון לצד תחתון

 . עצמו

 
 ?האם אתם רואים את החיתוך של החרוט והמישור? מה אתם רואים תוך כדי סיבוב
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 מהוות קבוצת האמת של מערכת המשוואותנקודות החיתוך של המישור  עם החרוט 
2 2 2x y z

x y z 1.5 0
 + =


+ − + =
 

 .המישור והחרוטשל החיתוך של  להצגה פרמטריתנעבור ,  יותר טובהחיתוךעל מנת לראות את 

  x  :[x, _______________, ______________ ] בעזרת  y, z את בטאו

 ?מהי עקומה המתקבלת. שרטטו את העקומה בחלון הגרפי      

 

במרחב  (x, y, z) לכל נקודה.   של חתך החרוט שמצאנוxy על מישור הטלהנחקור עתה את ה .ב

  [x, __________, 0]: הטל רשמו את ההצגה הפרמטרית של הה(x, y, 0).נתאים את הנקודה 

 ?  מה אתם רואים. z = 0הוסיפו גם את שרטוט המישור . והוסיפו אותה לשרטוט

 

ערכת המשוואות ממ. בדרך אחרתעתה נעבוד 
2 2 2x y z

x y z 1.5 0
 + =


+ − + =
 

 : בלבדy - וxבנעלמים , נובעות המשוואות הבאות

                                                           2 2x y x y 1.5± + = + + 

 את שני מעלים, תחילה: רמז( את המשוואה הזאת למשוואה פולינומיאלית בשני משתנים הפכו

  .)יהיזקה השנהאגפים לח
 

 מתאימה (x, y, z) היא הפונקציה אשר לכל נקודה במרחב ששיעוריה הם xy על מישור ההטלה .ג

 .היטלהתוצאה של ההטלה נקראת . (x, y, 0)את הנקודה ששיעוריה הם 
 . חקרו את  ההיטלים של חתכי החרוט הסטנדרטי עם המישורים הנתונים להלן      

1. x + z – 1 = 0 

2. x – y + 4z – 10 = 0 

 
 name10.2.dfw, שמרו את הקובץ שבניתם בשם שלכם  
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 10.2פתרונות והסברים לפעילות 

 dfw..210solution: ראו גם קובץ

 
התבוננות .  חותך את שתי היריעות של החרוטx + y – z + 1.5 = 0המישור שמשוואתו  .א

 . בשרטוט תוך כדי סיבוב מעלה את ההשערה כי חתך החרוט הוא היפרבולה

 :המישור והחרוטשל החיתוך של  להצגה פרמטריתנעבור ,  יותר טובהחיתוךלראות את על מנת 

 .x בעזרת  y, zנבטא את 

  
  . [x, y, z]כמובן המרכיבים של הוקטור הזה הם 

  .להלן שרטוט העקומה
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העקומה משורטטת על המישור משני נקודות להלן . הוספנו לחלון הגרפי את שרטוט המישור הנתון

 ):צד שמאל(מישור ל תחתוראיה מ) צד ימין(מישור ה עלראיה מ: מבט

  

 

 .הם שונים בשני השרטוטים. שימו לב לכווני הצירים: הערה

 

:  היאxy של העקומה על מישור טלהההצגה הפרמטרית של הה .ב
9 3[x, ,0]

4(2x 3) 2
−

+
 . 

 .xyאכן נראית היפרבולה על מישור .  ונסובבנוסיף את צירים, נשרטט

 

  

 

 

 

 

 

 

 

 

 

 

ממערכת המשוואות . נבדוק זאת בדרך אחרת
2 2 2x y z

x y z 1.5 0
 + =


+ − + =
 

 : בלבדy - וxבנעלמים , נובעות המשוואות הבאות

                                                           2 2 1.5x y x y± + = + + 
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 את שני האגפים מעלים(שוואה הזאת למשוואה פולינומיאלית בשני משתנים  את המנהפוך

  :ונקבל) הילחזקה השני

8·x·y + 12·x + 12·y + 9 = 0 
 היא xy על מישור ההטלה.  של חתך החרוטxyעל מישור משוואה הזו מתארת את ההטלה 

 ששיעוריה הם  מתאימה את הנקודה(x, y, z)הפונקציה אשר לכל נקודה במרחב ששיעוריה הם 

(x, y, 0) . היטלהתוצאה של ההטלה נקראת. 

 :שרטוט ההיטל      להלן

 .  היפרבולה שוות שוקייםנראית

 .xי " ע y ואת yי " ע xנמצא את האסימפטוטות על ידי שנבטא את 

 . x = -1.5   y = -1.5:  אסימפטוטות הןהמשוואות 

כך את ההיפרבולה משוואה קנונית נזיז היפרבולה חופפת לזו שקיבלנו בעלת על מנת לקבל 

 : שמשוואתההיפרבולה שוות שוקיים  נקבל .450  - ונסובב ב הצירים  לראשיתשמרכזה יעבור

4x2 - 4y2 - 9 = 0)  ראו בקובץDerive הסברים לטרנספורמציית הסיבוב . #27-#24) שורות

 8.4.מופיעים בפעילות 
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 . x + z – 1 = 0ט הסטנדרטי עם המישור שמשוואתו  להלן רואים את חתך החרומימין בשרטוט  .ג

ואמנם הוא מקביל לקו היוצר של  .המישור חותך רק את היריעה העליונה ונראה כפרבולה

2:  נמצא את משוואת ההיטל של חתך החרוט.החרוט 21 x (x y− = ± ידי העלאה לריבוע -על, +

22xופישוט מתקבלת משוואת פרבולה  y 1 0− − + השוו עם (במישור להלן שרטוט הפרבולה . =

 .מדייחתך החרוט בשרטוט התלת מ

 

 x – y + 4z -10 = 0  שמשוואתו היאהמישורידי -חתך החרוט הנוצר עלההיטל של נקבל כי  כך

 7x2 + 8y2 - 400/7 = 0.הוא אליפסה שמשוואתה הקנונית 

   
ים כך שגודל זווית הסיבוב ביחס למערכת הצירים בדוגמאות לעיל בחרנו את משוואות המישור

תוכלו לראות טיפול במשוואה כללית בשני  #63-#53)שורות ( Deriveבקובץ  .450הסטנדרטית הוא 

2:  נעלמים מהמעלה השנייה 2ax 2bxy cy 2dx 2ey f 0+ + + + + =  
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  חיתוך של חרוט עם מישור משתנה – 10.3פעילות 

 
 . רשמו משוואת החרוט הסטנדרטי ושרטטו אותו בחלון הגרפי התלת מימדי .א

 .x + az - 1 =0:  ידי המשוואה הפרמטרית-משפחת מישורים על      נתונה 

 . משתנהa כאשר ,יםת חתך החרוט עם המישורחקרו בעזרת סרגל גלישה כיצד משתנה צור
 .Insert>Slider Barבחלון הגרפי על  הקישולהוספת סרגל גלישה 

 משתנה ומצאו את משוואות a כאשר xyהדגימו כיצד משתנה ההיטל של חתך החרוט על מישור 

 .ההיטלים בדוגמאות שתבחרו

  .x - y + az - 1 =0:  הפרמטרית המשוואידי ה-משפחת מישורים עלנתונה  .ב

 . משתנהa כאשר ,יםחקרו בעזרת סרגל גלישה כיצד משתנה צורת חתך החרוט עם המישור      

 משתנה ומצאו את משוואות a כאשר xyהדגימו כיצד משתנה ההיטל של חתך החרוט על מישור 

 .ההיטלים בדוגמאות שתבחרו

 

 
 
 
 
 

 name10.2.dfw, שמרו את הקובץ שבניתם בשם שלכם 
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 10.3פתרונות והסברים לפעילות 
 dfw..301solution: ראו גם קובץ

 

2 רשמנו את משוואת החרוט הסטנדרטי  .א 2 2z x y= ושרטטנו את המשטח בחלון הגרפי   +

המתאים לערכים שונים של משוואת   המישוראת משטחעל מנת לשרטט . התלת מימדי

  . עלינו להפעיל סרגל גלישהx + az - 1 =0:  המישור עם פרמטר

1: ואה בצורה מפורשת     שימו לב יש לרשום את המשו xz
a
−

= 

 : במהלך הגלישה נראה כי

  חתכי החרוט הם אליפסותa| > 1|עבור 

 )המישור מקביל לקו היוצר של החרוט( חתכי החרוט הם פרבולות a| = 1|עבור 

  חתכי החרוט הם היפרבולותa| < 1|עבור 

אין נקודות " מופיעה הודעה – במכנה 0מאחר והביטוי המפורש מכיל ? a = 0מה קורה עבור 

 שהחיתוך שלו x = 1 במשוואה הנתונה תתקבל משוואת מישורa במקום 0אם נציב ". מתאימות

משנים את ,  תוך כדי תנועהdpg.a.310ראו גם את האנימציה בקובץ . עם החרוט הוא היפרבולה

aבעזרת ה -scrollbarרות השונות ואז רואים את הצו . 

 

לחקור את סוגי חתכי החרוט המתקבלים אם מתבוננים בערכי המקדמים במשוואה הכללית של ניתן 

xy :2ההיטל על מישור  2 2 2x (1 a) 2x a y 1 0− − − + אפשר גם לבחור דוגמאות מייצגות ולשרטט . =

x)2 במשוואה מתקבל משוואת ישר כפול aאם מציבים אפס במקום ( .אותן 1) 0− כאשר  לראותו שלא ניתן, =

 ). בגלל מגבלת תוכנהמשרטטים משוואה זו
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דוגמאות עבור מישור הנתון על ידי משוואה עם גם בתרגיל זה נפעיל סרגל גלישה לשרטוט  .ב

x: נרשום אותה בצורה מפורשת. פרמטר y 2z
a

− −
=  קיימת גם a = 0הבעייתיות לגבי . (−

 .)כאן

 :  כינשערך הגלישה במהל 

  חתכי החרוט הם אליפסות <  |a|2עבור

 )המישור מקביל לקו היוצר של החרוט( חתכי החרוט הם פרבולות  =  |a|2עבור

  חתכי החרוט הם היפרבולות > |a|2 עבור   

משוואה הכללית של ההיטל מוצאים את הו סוגי חתכי החרוט המתקבלים אם נאמת את השערתנ 

xy: 2על מישור  2 2 2x (1 a ) 2x(y 2) y (1 a ) 4y 4 0− − + + − + +  : ומשרטטים דוגמאות מייצגות=

 

 ):חתכי החרוט(של ההיטלים נוחה יותר  כלליתנותן משוואות  450 -סיבוב ב
2 2 2 2x (2 a ) 4 2x a y 4 0− + ⋅ + +  :  ומשרטטים דוגמאות מייצגות=
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 חתכי חרוט מנוונים – 10.4פעילות 

   .x + y = 0 י המשוואה " המוגדר עחקרו את החיתוך של החרוט הסטנדרטי עם המישור .א

 . x + z = 0 שמשוואתו היא חקרו את החיתוך של החרוט הסטנדרטי עם המישור  .ב

    .)xyהוא מישור  (z = 0 שמשוואתו היא המישור החיתוך של החרוט הסטנדרטי עם מהו .ג

 .z – ax = 0ונה משוואת מישור עם פרמטר נת .ד

 . משתנה aחקרו בעזרת סרגל גלישה כיצד משתנה צורת חתך החרוט עם המישורים כאשר 

 מתארת את ההיטל של החיתוך של 2x2 + 3xy – 2y2 = 0מצאו משוואת מישור כך שהמשוואה  .ה

 . המישור עם החרוט הסטנדרטי

 

 name10.4.dfw, מרו את הקובץ שבניתם בשם שלכםש 
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 10.4פתרונות והסברים לפעילות 
 dfw..410solution: ם קובץראו ג

 .x + y = 0 את החיתוך של החרוט הסטנדרטי עם המישור נחקור .א

להלן שלושה שרטוטים מתאימים . ד של שני קוים ישריםוהאיח חתך החרוט הוא כי  נגלהכאן 

  .למצב כזה

 

 :Deriveשרטוט בעזרת 

 :נמצא הצגה פרמטרית

 : קווים ישרים כי חתך החרוט הוא איחוד של שניבשרטוט רואים
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המישור , כאן. x + z = 0 שמשוואתו היאהמישור  את החיתוך של החרוט הסטנדרטי עם נחקור .ב

 של ישר יוצרהישר הזה הוא . אלא לאורך ישר שלם, אבל לא בנקודה אחת, משיק לחרוט

  .החרוט

 

 : והשרטוט [x, 0, -x]:       ההצגה הפרמטרית היא
 

 
 
הוא מכיל רק :  מנוון עוד יותרz = 0  שמשוואתו היאהמישור עם החיתוך של החרוט הסטנדרטי .ג

  .נקודה אחת

 
 

 חתך a = 1כאשר , חתך החרוט מכיל רק נקודה אחת a| < 1| עבור:כי נפעיל סרגל גלישה ונראה .ד

 .הוא איחוד של שני ישריםחתך החרוט  a| > 1|עבורו , ישר יוצר של החרוטהחרוט הוא 
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 2x2 + 3xy–2y2 =0 ממעלה שנייה המשוואהקבוצת האמת של ט משרטו המתקבלת "עקומה"ה .ה

" עקומה"ה .0 = (2x - y)(x + 2y)ואמנם פירוק לגורמים מאשר זאת , נראית כאיחוד של שני ישרים

 .עוברת דרך ראשית הצירים

 :ידי מישור כללי העובר דרך הראשית-עלשל היטל של חתך חרוט שנוצר  הנמצא משווא

 . a, b, cל מערכת משוואות שפתרונה ייתן את המקדמים נשווה מקדמים ונקב

 
 איחוד של –נשרטט את המישור ונראה חתך חרוט מנוון ,  של המערכתנבחר באחד הפתרונות

 :שני ישרים

 

הקשר עם המשוואה . V [x, 2x, 0] [x, -x/2, 0]:  הואxyההיטל של איחוד הישרים על מישור 

 .ברור) בצורתה המפורקת(הנתונה 
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 .DPGraph  בעזרת –חיתוך של חרוט עם מישור משתנה :  נספח
 לכן נוכל .יש יכולת לשרטט משטחים שקופים בדרגות שונות של שקיפות, PDGraphלתוכנה אחרת 

ניתן להוריד , שיצרנו בעזרת תוכנה זוכדי לפתוח את הקבצים . להשתמש בה כדי לראות חתכי חרוט

להפעיל לראות את השרטוטים וכך תוכלו .  http://www.dpgraph.comהאתר חינם מן Viewer -את ה

  :ראו .את האנימציות

cone-circle.dpg, cone-ellipse.dpg,   cone-hyperbola.dpg,   cone-parabola.dpg, cone-lines.dpg 

  .במחשב, Viewer -לא רק את ה, את התוכנה עצמה יש להתקין DPGraphכדי לבנות קבצי 

 .להלן הנחיות לעבודה עם תוכנה זו).    http://www.dpgraph.comראו (

 מופיע סרגל תפריט PDGraphבמסך הפתיחה של .פתור כבשולחן העבודה לחצו על ה .1

 .נפתח חלון . Editלחצו על . למעלה

 

 

או (של המשטח ) או למשוואות(השורה התחתונה בחלון עם רקע לבן מיועדת למשוואה 

בעזרת העכבר אפשר להיכנס לשורה הזאת ולשנות את . ו מבקשים לשרטטשאנ) המשטחים

 Executeפתור כתעשו את זה ולחצו על ה.  את משוואת החרוט הסטנדרטירשמו .הכתוב

 .בתחתית חלון התפריט

 ונוסיף את Edit -נחזור ל, לצורך זה: ל"הנידי -הנתון על את המישור ברצוננו לשרטטכעת 

שימו לב ( בשורה התחתונה של החלון בעל הרקע הלבן x + y – z + 1 = 0משוואת המישור 

 ):במידה ואתם רוצים לשרטט יותר ממשטח אחד יש לשים סוגריים כפולים, לסוגריים

graph3d( ( x^2+y^2=z^2, x+y-z+1=0 ) ) 
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 dpg.1Example? מה רואים

 ין עד השורה בחלון הלבן נעלה בעזר הכפתור הנע בצד ימ: Editנחזור לחלון התפריט 

graph3d.transparency := 0 

  ביןהערכים נעים.  קובע את מידת השקיפות של השרטוטgraph3d.transparencyערך הפרמטר 

. 0.5בערך ) שמשמעותו אין שקיפות (0נחליף את הערך ). שקיפות מלאה (1 -ל) אין שקיפות  (0

 .נסו ערכים שונים עבור פרמטר השקיפות? מה אתם רואים

 dpg.2Example 0.5 -ן השרטוט כאשר פרמטר השקיפות שווה ללהל

 

 

 
:  בסרגל התפריט הראשי ותנסו מספר אפשרויותColor -תכנסו ל. אולי ריבוי הצבעים מפריע לכם

 .dpg.3Example צבע אחיד, )steepness(לפי שיפוע , צבע לפי גובה

 

ו את ערך הפרמטר החליפ: Editאפשר לחדד את הרזולוציה באמצעות התפריט  .2

graph3d.resolution ערכו הסטנדרטי כאשר מריצים את  (21 - מDPGraph בתחילת העבודה  (

תתחילו , באחת מן הקומבינציות של ערכי הפרמטרים. נסו מספר אפשרויות. לערך גבוה יותר

. graph3d.resolution=100קבעו  ,הלדוגמ :לראות טוב יותר את החיתוך של החרוט עם המישור

 עקומת החיתוך נראית בבירור. transparency.d3graph=0 -ודאו ש, באותה הזדמנות

dpg.4Example. 
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.  בסרגל התפריט הראשיAnimateלחצו על , כדי לסיים את הפעילות הזאת בצורה דינמית

 .נסו זאת.  ועצירה(continusously rotate)סיבוב רציף : מציעים שתי אפשרויות

 

 בעזרת סרגל הגלישה ונשנה אות. aהמישור תלוי בפרמטר  בהן דוגמאותראיתם  10.3בפעילות  .4

 נפתח Scrollbarאחרי לחיצה בשם ?  אותו התפריטומצא. Scrollbar הנקרא DPGraphשל 

או הפעילו את (בנו דוגמאות משלכם . תחילו לגרור את הכפתורה וaבחרו את : תפריט ספציפי

 ?מה רואים .)  dpg.a.310  dpg.b.310 הדוגמאות 

 


